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What Are Icons?

Icons are representations of objects, concepts, and actions that convey visual information about
their purpose.    In computer software like Windows, icons are small pictures -- typically 32 by 
32 screen dots (pixels) -- that are used to represent various types of files on disk, as well as 
represent command functions and visual cues within applications.

Windows uses a number of different types of icons on the desktop and in Program Manager to 
represent application and document files (described below).    These icons are not actual files -- 
the icons just represent files.    If you delete an icon in Program Manager, for example, you 
delete only the visual reference to the application or document file, not the real disk file itself.

Icons themselves are contained in files.    A special file format named with the file name 
extension of .ICO is used to contain one or more icon image.    Icons can also exist in various 
types of files, such as .EXE and .DLL.    See Files That Contain Icons for information.

Types of icons Windows uses to represent application and document files:

- An application icon represents an application that is running, but whose window is not 
open at the time.    The application window has been reduced to an icon (minimized) on the 
Windows desktop, usually at its bottom edge.

You can move an application icon (that is, the icon for a running application) anywhere on 
the desktop, except into an open window.    This is because the icon represents an open 
application, and applications run only on the desktop, not inside of documents or other 
applications.

- A document icon represents a document window that has been minimized within an 
application that supports the "multiple document interface" (MDI), such as Program 
Manager and File Manager.    These icons generally appear along the bottom edge of the 
application window and can be moved anywhere within it.

In Program Manager, such an icon is called a program group.    This term refers to the open
window state of the group as well.

In many applications, the icons that represent document windows look the same.    Only the
labels that identify them are different.

- A program item icon represents an application that you can run, or a document file that 
will run its associated application.    These icons are contained within program groups in 
Program Manager.    You can move or copy program item icons from one program group to 
another.

Most program item icons look unique.    However, Program Manager uses a default icon 
that is identical for all DOS programs.    Also, for many applications, you can run more than
one copy of it.    Program item icons for multiple copies of applications are identical.    



Thus, a program group window might contain several identical program item icons 
distinguished only by their labels.



Files That Contain Icons

Many file types can contain Windows icons.    Since icon images are stored in a standard 
format, an icon handling application like IconWorks Pro can read them easily from many 
different file types.

In IconWorks Pro, a few terms are used when referring to icons and the files containing them:   
Icon in general refers to a displayed icon image.    Icon file is used to refer to .ICO and .ICN 
files.    Icon library file is used to refer to any other file types that contain icons.    The file 
types are described below:

- The file format made especially for single icons is files with the file name extension of
.ICO.    This type of file usually contains one icon, but it can contain multiple icon images 
used for different screen resolutions (such as VGA, CGA, and mono).    Sometimes older 
icon files are named with the file name extension of .ICN, but .ICO is the accepted 
standard naming in Windows.

IconWorks Pro cannot read icon files stored in archive files, like .ZIP (PKZIP), .LZH 
(LHA), .ARJ, and self-extracting variations.    They must be uncompressed.

- Windows application executable files -- those with the file name extension of .EXE -- 
contain one or more icons used for representing the application in Program Manager, when 
the application is minimized on the Windows desktop, and for various things within the 
application itself (like command buttons, tool bars, message dialogs, and in the About box).

- Windows "dynamic link library" files -- those with the file name extension of .DLL -- may 
contain a few icons, or nothing but icons.    This file type is mainly used to contain support 
code for an application, so icons may not be found in many of them.    However, 
some .DLL files are used to contain just support icons for an application in a compact 
format.    An example of such a file is the MORICONS.DLL file included with Windows 
(though that one it is not required by any application).

- Other file types are used especially for icon collections.    These files have file name 
extensions of .ICL, .ICA, .IL, .NIL, .LIB, and more.    The most common seems to 
be .ICL (meaning "ICon Library") used by a popular icon handling application called Icon 
Manager (.ICA is also used by it, probably meaning "ICon Archive").    .IL (also meaning 
"Icon Library") is used by hDC Icon Designer.    .NIL (meaning "Norton Icon Library") is 
used by Norton Desktop.    Others like .LIB seem to be rarely used for icon collections.

Two special icon library file formats with file name extensions of .IML and .IMZ are used 
by another popular icon handling application called IconMaster.    Those formats are 
compressed in a way that is specific to IconMaster, and other icon handling applications 
including IconWorks Pro cannot read them.



Changing Icons in Program Manager

When you add a program item to a program group, Program Manager selects an icon for that 
item.    You can change an icon in Program Manager by using any of the following methods:

- Quite often multiple icons are stored within an application, and you can use any of them.    
First select the program item icon that you want to change.    Choose Properties from the 
File menu, and then choose Change Icon in the Program Item Properties dialog box.    
You can scroll through the available icons in the Current Icon area if necessary using the 
scroll bar.    If there is only one icon shown, then you must use one of the other methods 
below to change the icon.    If there are no icons available for the program item you 
selected, Windows displays the Change Icon dialog box with PROGMAN.EXE specified, 
which allows you to assign an icon from those contained in Program Manager itself.

- You can use one of the many icons provided with Program Manager.    First select the 
program item icon that you want to change.    Choose Properties from the File menu, and 
then choose Change Icon in the Program Item Properties dialog box.    In the File Name 
box, enter PROGMAN.EXE (if there are no icons available for the program item you 
selected, Windows displays the Change Icon dialog box with PROGMAN.EXE already 
specified).    You can now select any of the Program Manager icons to use with the selected 
program item (scroll through the available icons in the Current Icon area using the scroll 
bar).

- You can use one of the many icons designed especially for DOS programs, found in the 
MORICONS.DLL file which is installed in the Windows directory.    The procedure is the 
same as above, except use MORICONS.DLL in the File Name box.

- You can use one of the many hundreds of thousands of icons available from many sources, 
such as CompuServe, America Online, local BBS systems, icon software packages, etc.    
Icons can be found as individual icon files, collections of icon files, and icon library file 
collections.    The procedure is the same as above, except use the path and name of the icon 
file or icon library file in the File Name box. *

- You can design your own icons or extract icons from files using IconWorks Pro.    Once you
save an icon to an icon file, you can use that icon for a program item.    Again, the 
procedure is the same as above, except use the path and name of the icon file in the File 
Name box. *

*    IconWorks Pro offers a convenient command that automates the process of changing a 
program item icon in Program Manager.    It allows you to use any icon viewed in the Viewer 
for a selected program item.    See the Viewer Edit menu for information on the Change Icon in 
ProgMan choice.



Editor:    Commands

Menus: Tools:
File Select
Edit Paint
View Fill
Tools Line
Brush Square
Color Filled Square
Icons Circle
Help Filled Circle

Status Area: Zooming Scroll Bar
Six Icon Boxes Color Palette
Original Icon Display
Mouse Position Display
Mouse Color Controls



Editor:    File Menu

New
Clears the editing area and the current icon to start a new one.    If there are unsaved changes 
for the current icon, you are asked if you want to discard them.

Viewer
Opens or switches to the Viewer so you can open icons for editing.

Save
Saves changes made to the current icon.    If the current icon is untitled, the Save As dialog 
box appears so you can name the icon file.

Save As
The Save As dialog box appears so you can save the current icon to an icon file.

The Editor remembers the directory used for the Save As command between runs.

Exit
Exits the Editor.    If any of the six icons in the Status Area have unsaved changes, you are 
asked if you want to discard them and exit anyway.    If the Viewer is also open, you are 
asked if you want to terminate the Viewer if you started the Viewer after the Editor.    If you 
started the Viewer first, then the Editor closes leaving the Viewer running.



Editor:    Edit Menu

Undo
Restores the current icon to its state immediately before the last change made, working like 
an undo/redo combination.    You can also right-click on the Original icon display in the 
Status Area to activate the Undo command.

Multi Undo
Displays a window containing the last three states of the current icon from which you can 
select to restore.    The icons in this window are updated from left to right, and the number of 
the icon shown in red is the state immediately before the last change made.    You can also 
right-click on any of the six icons in the Status Area to activate the Multi Undo command for 
that icon.

Original
Restores the current icon to its original state at the time you highlighted its icon box.    When 
you select an icon, the Original icon display in the Status Area is reset to the current state of 
the selected icon.    It displays the condition the icon will be restored to if you select the 
Original command or click on the Original icon display.

Cut
Copies the portion of the editing area you select to the Clipboard, and clears the selected area
to the current screen color.    The Cut command does not work if you move the part of the 
icon you select before cutting it; you must reselect the area you want to cut and then use the 
Cut command.

Copy
Copies the portion of the editing area you select to the Clipboard.    The editing area is not 
affected.    The Copy command does not work if you move the part of the icon you select 
before copying it; you must reselect the area you want to cut then use the Copy command.

Copy Icon
Copies the bitmap image of the current icon to the Clipboard.    This command is a quick one-
step replacement for using the Select All and Copy commands.

The icon itself cannot be copied to the Clipboard, only a bitmap image; however, the bitmap 
will be converted to an icon when pasted into the Editor.

Paste
Inserts the contents of the Clipboard as a selected group of pixels in the upper-left corner of 
the editing area.    You can then move the selection anywhere in the editing area before 
pasting them in the current icon.    To paste the selection into the icon, click the mouse 
anywhere in the editing area outside of the selection.

All pixels in the pasted bitmap that match the current screen color appear transparent and do 
not affect the icon below.    Pixels that match the inverse color of the screen color replace the 
pixels in the icon.



Paste Opaque
Same as Paste, except that all pixels in the bitmap cover any pixels in the icon below 
regardless of screen and inverse color.

Delete
Deletes the selection in the editing area from the icon, replacing the selection with the current
screen color.

Select All
Selects the entire icon in the editing area.    You can also double-click the Select tool to select 
the entire icon.

Flip Horizontal
Flips the current selection in the editing area from left to right (the horizontal edges).

Flip Vertical
Flips the current selection in the editing area from top to bottom (the vertical edges).

Rotate 90° Right
Rotates the current selection in the editing area 90 degrees to the right.

Rotate 90° Left
Rotates the current selection in the editing area 90 degrees to the left.

Invert
Changes all the colors in the current selection to their opposites.    The picture below shows 
the normal color palette and the inverted color palette so you can see how the colors change 
when using the Invert command.



Editor:    View Menu

Center Window
Moves the Editor window to the center of the screen.    Useful for when the Editor window 
has been resized or moved, and you want it back in center view.    Unavailable when the 
Editor window is maximized.

Status Area
Hides or displays the Status Area.    Unavailable if the Editor window is too small to display 
the Status Area.

Tool Palette
Hides or displays the Tool Palette.    Unavailable if the Editor window is too small to display 
the Tool Palette.

Color Palette
Hides or displays the Color Palette.    Unavailable if the Editor window is too small to display
the Color Palette.

Zooming Scroll Bar
Hides or displays the Zooming Scroll Bar.

Show All
Displays all hidden Editor controls:    The Status Area, Tool Palette, Color Palette, and 
Zooming Scroll Bar.    If the Editor window is too small to display a specific control, that 
control remains hidden.

Grid
Turns the grid on and off.    The grid helps you tell individual pixels apart in the editing area.  
When the grid is on you can select between a solid line grid or a dotted grid.

Line Grid
Displays the grid as solid lines.    Unavailable when the grid is turned off.

Dotted Grid
Displays the grid as rows and columns of dots.    Unavailable when the grid is turned off.

Zoom In
Magnifies the appearance of the icon in the editing area.    You can also zoom in on an icon 
with the Zooming Scroll Bar.

Zoom Out
Reduces the appearance of the icon in the editing area.    You can also zoom out from an icon 
with the Zooming Scroll Bar.

Focus on Icon Open / Drag & Drop



When switched on, the Editor will be brought to the foreground when you open an icon from 
the Viewer.    When switched off, you can open icons in the Viewer without bringing the 
Editor to the foreground.

Advance to Next Icon on Open
When switched on, the icon highlight in the Status Area of the Editor will advance to another 
icon box when you open an icon from the Viewer.    The icon highlight will advance to the 
first unoccupied (new) icon box; if all are occupied, then it will advance to the next 
unchanged (loaded but unedited) icon box; if all are changed, then it will advance to the 
immediate next icon box and ask to discard changes.    This option allows you to quickly 
pump icons into the Editor with the least amount of effort.    When switched off, opening an 
icon from the Viewer will replace the current icon (asking to discard changes if necessary).

Display Border on Current Icon
Displays or hides a border showing the edge of the current icon in the Status Area.

Popup Tools Menu on Right Click
When switched on, this command lets you popup the Tools menu when you right-click 
around the border of the editing area.



Editor:    Tools Menu

How to Select a Tool
You can select tools in the Editor in the following ways:

- Click on the icon for the tool in the Tool Palette.
- Select the name of the tool from the Tools menu.
- Right-click around the border of the editing area to popup the Tools menu and select the 

name of the tool (when the Popup Tools Menu on Right Click option in the View menu is 
switched on).

Select Tool
Selects a rectangular region in the editing area.

To use the Select tool, click in the editing area to anchor one corner of the area you want to 
select.    Drag the mouse until the flexible box that appears surrounds the area you want to 
select.    Release the mouse button.    If you make a mistake while selecting or want to cancel 
the action, click outside of the current selection.

Paint Tool
Paints pixels in the editing area according to the selected brush size.

To use the Paint tool, click the mouse in the editing area, and drag if desired.

Fill Tool
Fills a closed area with the color selected in the Color Palette.

To use the Fill tool, click in the area to be filled.    The area will be filled with the color 
selected in the Color Palette.    The Fill tool fills adjacent pixels which are the same color as 
the starting pixel.    If you fill an area with a dithered color rather than a solid color, the result 
will be a checkerboard pattern, however smaller areas may end up just one color.

Line Tool
Draws straight lines.

To use the Line tool, click in the editing area to anchor one end of the line.    Drag the mouse 
until the mouse reaches the other end of the line you want to draw.    Release the mouse 
button to draw the line in the icon.    The width of the line corresponds to the current brush 
size.    The color of the line is the color selected in the Color Palette.

To draw a horizontal, vertical, or diagonal line, hold down the SHIFT key as you drag the 
mouse.

Square Tool
Draws rectangles and squares.

To use the Square tool, click in the editing area to anchor one corner of the square.    Drag the
mouse until the square is the size and shape you want.    When the square or rectangle is the 



right size and shape, release the mouse button.    The brush size determines width of the box's 
border.    The color of the outline of the square is determined by the Color Palette.

To draw a perfect square, hold down the SHIFT key as you drag the mouse.

Filled Square Tool
Draws filled rectangles and squares.

To use the Filled Square tool, click in the editing area to anchor one corner of the square.    
Drag the mouse until the square is the size and shape you want.    When the square or 
rectangle is the right size and shape, release the mouse button.    The brush size determines 
width of the box's border.    The color that fills in the square is determined by the Color 
Palette.

The border of the square is a line and therefore cannot be drawn using dithered colors.    If 
you select a dithered color the border of the square will appear in the nearest solid color.    If 
you want the entire square to be drawn with a dithered color, first draw the square with a 
solid color then use the Fill tool to fill it in with the desired dithered color.

To draw a perfect square, hold down the SHIFT key as you drag the mouse.

Circle Tool
Draws circles and ellipses.

To use the Circle tool, click in the editing area to anchor one corner of a flexible box 
containing an ellipse.    The box appears while you draw to show the anchor point and current
mouse position.      It disappears when you finish drawing.    Drag the mouse until the ellipse 
is the size and shape you want.    When the circle or ellipse is the right size and shape, release 
the mouse button.    The brush size determines the border width of the circle or ellipse border. 
The color of the circle or ellipse border is determined by the Color Palette.

To draw a perfect circle, hold down the SHIFT key as you drag the mouse.

Filled Circle Tool
Draws filled circles and ellipses.

To use the Filled Circle tool, click in the editing area to anchor one corner of a flexible box 
containing an ellipse.    The box appears while you draw to show the anchor point and current
mouse position.      It disappears when you finish drawing.    Drag the mouse until the ellipse 
is the size and shape you want.    When the circle or ellipse is the right size and shape, release 
the mouse button.    The brush size determines the border width of the circle or ellipse border. 
The color that fills the circle or ellipse is determined by the Color Palette.

To draw a perfect circle, hold down the SHIFT key as you drag the mouse.

The border of the ellipse is a line and therefore cannot be drawn using dithered colors.    If 
you select a dithered color the border of the ellipse will appear in the nearest solid color.    If 
you want the entire ellipse to be drawn with a dithered color, first draw the ellipse with a 
solid color then use the Fill tool to fill it in with the desired dithered color.



Editor:    Brush Menu

Choose: To set the tool drawing size to:
Small (1 x 1) 1 by 1 pixel wide
Medium (3 x 3) 3 by 3 pixels wide
Large (5 x 5) 5 by 5 pixels wide
Huge (7 x 7) 7 by 7 pixels wide

The brush size does not affect the Select and Fill tools.

Mouse Pointer Type
Sets the mouse pointer type used for the tools in the editing area.    Default Pointers sets the 
pointer to Up Arrow for the Paint and Fill tools, and to Crosshair for the other tools.    The 
rest of the commands affect the pointer for all of the tools.

Arrow (Windows) sets the pointer to the global Windows pointer, which is normally a left-
slanted arrow.    Note that if some other utility has installed a custom mouse pointer, then you 
will see that and not the normal Windows arrow.



Editor:    Color Menu

Custom Color Palette
Opens the Custom Color Palette window, where you can define custom colors and assign 
them to the current color palette.    You can use the Custom Color Palette to select colors in 
the same way you select colors with the Color Palette in the Editor window.

You can use the Custom Color Palette as a floating color palette instead of displaying the 
Color Palette in the Editor, if desired.

Default Color Palette
Sets the color palette to the default solid and dithered colors.

Solid Colors Only
Sets the color palette to solid colors only.    Each column of cells is set to the same color.    
Because some tools cannot use dithered colors, this command ensures that any color you 
select can be used by any tool.

INI File Color Palette
Sets the color palette to the values stored in the IWPRO.INI file.    If this file does not exist, 
or you have never saved changes to the color palette, the color palette resets to the default 
colors.

Save Color Palette to INI File
Saves the current color palette settings to the IWPRO.INI file.    This file is created in the 
Windows directory if it does not exist.

Left / Right Colors
Sets the current mouse colors to those currently displayed in the Status Area for the Left and 
Right colors.    You can also set the current mouse colors by selecting the corresponding 
option button in the Status Area.

Screen / Inverse Colors
Sets the current mouse colors to those currently displayed in the Status Area for the screen 
and inverse colors.    You can also set the current mouse colors by selecting the corresponding
option button in the Status Area.



Editor:    Icons Menu

Enables you to select and display an icon from the Status Area when it is not displayed.

Choose: To select and display:
#1 - [path]    filename the upper-left icon
#2 - [path]    filename the upper-right icon
#3 - [path]    filename the middle-left icon
#4 - [path]    filename the middle-right icon
#5 - [path]    filename the lower-left icon
#6 - [path]    filename the lower-right icon

The full path and file name of the icons appear in the appropriate menu item.    Selecting an 
icon from the Icons menu is equivalent to clicking the corresponding icon in the Status Area.

After saving an icon, its path and file name will become uppercase to let you know that the 
icon has been saved at least once since it was opened.

When you select the current icon from the Icons menu, it initiates test-dragging of the icon.



Help Menu

The commands in this menu open the help file you are now reading.    The How to Use Help 
command presents information on using the Windows Help system.



Editor:    Status Area

The Status Area is the part of the Editor window that is to the right of the editing area and the 
Color Palette.    The Status Area displays information and provides controls that help you as 
you use IconWorks Pro.

When you resize the Editor window, items are removed from the Status Area as the Editor 
becomes too small to display them.    These items are displayed again when the Status Area 
becomes big enough to fit them in the window.    The entire Status Area disappears if the Editor
window becomes too small to display the six icon boxes.    In this case, you must choose the 
Status Area command from the View menu to redisplay the Status Area.

The Status Area has four sections:

Six Icon Boxes
Original Icon Display
Mouse Position Display
Mouse Color Controls



Six Icon Boxes

The top part of the Status Area contains six icon boxes that serve the following uses:

- Displays up to six icons open for editing.
- Displays the actual size of the icons being edited.
- Indicates the current icon with a square highlight border.
- Switches between the icons by clicking on the icon box you want to edit.
- Calls up the Multi Undo window by right-clicking on the icon box you want to undo.
- Lets you test-drag the icons to see how their transparent areas appear when dragged.

See Also
Status Area



Mouse Position Display

Displays the current X and Y position of the mouse pointer when in the editing area.

See Also
Status Area



Original Icon Display

Displays the condition the current icon will return to if you select the Original command in the 
Edit menu or if you click on the Original icon.

See Also
Status Area



Mouse Color Controls

Displays the colors applied by the Left and Right mouse buttons when editing an icon.    You 
can choose between foreground colors or screen and inverse colors.

See Also
Status Area



Editor:    Color Palette

The Color Palette contains solid and dithered colors you can use when editing an icon.

To select a color from the palette, click a color cell with the left or right mouse button.    The 
selected color is assigned to the mouse button used to click the color cell.    You use this 
procedure to assign foreground colors as well as screen and inverse colors.

Double-clicking a mouse button assigns the selected color to that button and opens the Custom 
Color Palette, where you can define colors.



Editor:    Defining Colors with the Custom Color Palette

You can define colors using the Custom Color Palette.    To open the Custom Color Palette, 
select the Custom Color Palette command from the Color menu or double-click the Color 
Palette at the bottom of the Editor.    Minimizing or closing the Editor window also hides or 
closes the Custom Color Palette window.

Color Elements and Values
Custom colors are composed of RGB -- red (R), green (G), and blue (B) -- elements.    These 
elements have values ranging from 0 to 255.    A value of 0 means none of that color appears 
in the custom color.

Setting Color Values
Use the RGB scroll bars to set the individual color elements.    You can also enter color values
into the edit fields to the right of each scroll bar.    The color cell to the right of each edit field 
displays the color matching the value chosen for each RGB element.

The Selected Color cell displays the RGB color created by combining the individual RGB 
elements.    Since some of the tools cannot use dithered colors, the Nearest Solid Color is also
displayed.

Adding Custom Colors to the Editor
To add a color to the Color Palette in the Editor, click the Set button.    The color cell 
currently selected in the Editor changes to display the new custom color.

Clicking the Reset button resets the RGB elements to the color values for the color cell 
currently selected in the Editor.

Defining Additional Colors
To define another color, click on a color palette cell in the Custom Color Palette window.



Editor:    Screen and Inverse Colors

Screen Color, Inverse Color, and Transparency
The color you select as the Screen color controls the background of the icon.    The 
background of the icon is any area that has not been painted with a color.    When you change 
the Screen color setting, you will see how different window colors would show through the 
empty areas of the icon.    (The default window color would be that as set in Windows 
Control Panel.)    When you drag the icon, any part of the icon colored with the Screen color 
appears transparent, displaying the colors on the screen beneath it.

The current Screen color being displayed in the icon is not actually part of the icon -- that 
color is just being used to show the empty areas of the icon.    Therefore, set the Screen color 
to a color that is different than the Left / Right foreground color you want to paint with, so 
you can see where the transparent areas are.

For example, the default Screen color is white.    If you want to paint with the real color 
white, set the Screen color to a color that appears least in the icon being edited.    Remember 
to switch back to the Left / Right setting to begin painting.

The Inverse color is also transparent when you drag the icon, however it inverts the colors on
the screen beneath it.

You can test-drag icons in the Status Area to see how their screen and inverse transparency 
appears.

Selecting Screen and Inverse Colors
The Screen and Inverse colors can only be solid colors.    The Screen and Inverse colors act 
as a pair when selecting colors.    When you select a color for either the Screen or Inverse 
color, the other color in the pair is automatically set to the inverse of the color you select.    
For instance, if you set the Screen color to black, the Inverse color is set to white.



Editor:    Original Icon

The Original icon display in the Status Area shows the condition the current icon was in when 
you last highlighted its icon box.    You can undo your changes to this icon by clicking the 
Original icon display or by choosing the Original command from the Edit menu.

The Original icon display is hidden if you size the Editor window too small to display the 
entire Status Area.



Editor:    Procedures

Zooming In and Out
Moving a Selection
Flipping a Selection
Rotating a Selection
Test-Dragging Icons



Editor:    Zooming In and Out

The vertical scroll bar along the left side of the editing area increases or decreases the 
magnification of the current icon.

You can use this scroll bar to display the icon at actual size or magnify it to fill the editing area,
which can be as large as the Editor window size allows.    When you resize the Editor, the scroll
bar adjusts to the new window size so that the icon stays at the same magnification.



Editor:    Moving a Selection

Once you select part of the editing area with the Select tool, there are two ways to move it:

Opaque Move Use the right mouse button to click and drag 
the selected pixels.    The selection is moved as 
is, including all foreground colored pixels and 
all screen and inverse screen colored pixels.

Transparent Move Use the left mouse button to click and drag the 
selected pixels.    Only the foreground colored 
pixels move.    This lets you move regions in 
the icon that appear to be a non-rectangular.

Holding down the SHIFT key while moving a selection leaves a copy of the selected pixels at 
their original location.

Once you move the selection, the selection rectangle changes from a dotted rectangle to a solid 
rectangle.

The moved selection is committed to the current location by clicking the mouse anywhere in 
the editing area outside of the selection, or by selecting another tool or icon.



Editor:    Flipping a Selection

Once you select part of the editing area with the Select tool, you can flip the selected pixels 
either horizontally or vertically by using the Flip Horizontal and Flip Vertical commands in the
Edit menu.

The selection does not have to be square in order to be flipped.

You can also flip a selection while it is being moved.



Editor:    Rotating a Selection

Once you select part of the editing area with the Select tool, you can rotate the selected pixels 
90 degrees to the right or left by using the Rotate 90° Right and Rotate 90° Left commands in 
the Edit menu.

The selection must be square in order to be rotated.

You cannot rotate a selection while it is being moved.



Editor:    Test-Dragging Icons

You can test-drag icons to see what they look like when dragged.    This ability is especially 
helpful when icons contain transparent regions.

To test-drag an icon, click and drag the current icon from its icon box in the Status Area, or 
select its choice from the Icons menu.    Click anywhere to stop dragging.    (You cannot drop 
icons dragged from the Status Area.)



Viewer:    Commands

Menus:
File
Edit
View
Options
Help



Viewer:    File Menu

Open Icon
Opens or switches to the Editor and opens the Selected Icon for editing.    Unavailable if you 
have not selected an icon.

There are several ways you can select and open icons into the Editor.

Editor
Opens or switches to the Editor without opening an icon.

Delete File
Asks if you want to delete the file highlighted in the file list.    Unavailable if you have not 
highlighted a file.

Exit
Exits the Viewer.    If the Editor is also open, you are asked if you want to terminate the 
Editor too if you started the Editor after the Viewer.    If you started the Editor first, then the 
Viewer closes leaving the Editor running.



Viewer:    Edit Menu

Copy Icon
Copies the bitmap image of the Selected Icon to the Clipboard.    Unavailable if you have not 
selected an icon.

The icon itself cannot be copied to the Clipboard, only a bitmap image; however, the bitmap 
will be converted to an icon when pasted into the Editor.

Change Icon in ProgMan
Automates the process of changing a program item icon in Program Manager.    Unavailable 
if you have not selected an icon.

Save New Icon File
Asks you to first save an icon file for the Selected Icon.    This is the only command 
available when Icon Library File Mode is on, since no icon file exists yet for the Selected 
Icon.

Use Existing Icon File
Uses the existing icon file of the Selected Icon.    Unavailable when Icon Library File 
Mode is on.

Program Manager must be detected running in order to use these commands.    The program 
item you want to change must be selected in Program Manager before proceeding with these 
commands.    You can switch to Program Manager at any time before proceeding to confirm 
your selection.    It does not matter if Program Manager is minimized, however the program 
group containing the program item selection must be open.

The Viewer remembers the directory used for the Save New Icon File command between 
runs.



Viewer:    View Menu

Center Window
Moves the Viewer window to the center of the screen.    Useful for when the Viewer window 
has been resized or moved, and you want it in center view.

Upper-Left Window
Moves the Viewer window to the upper-left edge of the screen.    Useful for getting the 
Viewer window out of the way of the Editor when both are open.

These commands are unavailable when the Viewer window is maximized.



Viewer:    Options Menu

Icon Library File Mode
Toggles the icon viewing mode between the viewing of icon files and icon library files.    The 
Icon Library File Mode check box in the Viewer window serves the same purpose.

Show All Icon Files
Displays all of the icon files listed in the file list box in the viewing area on the right side of 
the Viewer window.    Unavailable when there are no icon files in the current directory, or 
when Icon Library File Mode is on.

Show All on Directory Change
When switched on, and Icon Library File Mode is off, causes the viewing area to be updated 
when you change to a directory containing one or more icon files.    When switched off, you 
must use the Show All Icon Files command to update the viewing area when desired.

Ask to Show Icons
When switched on and set appropriately, asks if you want to show the icons when there are 
more than 50, 100, 200, or 300 in an icon file directory or icon library file.    Useful if you 
have large icon collections and want to avoid sitting through an unintentional showing, 
especially with a slow computer.

Just Beep on Invalid / No Icons
When switched on, will just beep instead of displaying a message box when an invalid icon 
file or an empty icon library file is encountered.



Viewer:    Procedures

Viewing Icons
Selecting Icons to Edit



Viewer:    Viewing Icons

Viewing Individual Icon Files    (Icon Library File Mode off)
You can view individual icon files one at a time by clicking on them in the file list box.    The 
selected icon file appears as the Selected Icon displayed at the top of the Viewer window.

Viewing All Icon Files in a Directory    (Icon Library File Mode off)
To view all of the icon files in a directory at the same time, select the Show All Icon Files 
command from the Options menu.    Each icon appears in the viewing area to the right of the 
list, where you can click on them to select one as the Selected Icon.    Icon files that are 
invalid appear as solid black squares and cannot be selected.    If the Show All on Directory 
Change option in the Options menu is on, the Show All Icon Files command is automatically 
engaged when you change to a directory containing icon files.    The viewing area is cleared 
when you change the current directory, or select No in an Ask to Show Icons message box.

Viewing Icon Library Files    (Icon Library File Mode on)
You can view icon library files by clicking on them in the file list box.    Each icon in the 
selected icon library file appears in the viewing area to the right of the list, where you can 
click on them to select one as the Selected Icon.    The viewing area is cleared when you 
change the current directory, select an empty icon library file, or select No in an Ask to Show
Icons message box.

When there is only one icon file in a directory or one icon in an icon library file, it is 
automatically selected for the Selected Icon.

The number of the Selected Icon is displayed on the far right of the menu bar.    This makes it 
easy to track icon files or see what icon position you are at in an icon library file.

In either viewing mode, up to a maximum of 1,800 icons can be displayed at one time.    As 
many icons as possible will be displayed when a low memory condition is encountered.

The Viewer remembers the last directory viewed between runs.



Viewer:    Selecting Icons to Edit

There are several ways you can select icons in the Viewer to open them into the Editor for 
editing:

- When an icon is shown for Selected Icon, use the Open Icon command in the File menu.
- Right-click on any displayed icon.
- Drag any displayed icon from the Viewer and drop it on the editing area of the Editor or on 

one of the six icon boxes in the Status Area of the Editor.
- When an icon is shown for Selected Icon, press ENTER when the focus is in the file list 

box or in the File Name text box.



The IWPRO.INI File

When you close the Editor and Viewer, most of their settings are saved to the IWPRO.INI 
initialization file in the Windows directory.    The only exception is the current color palette 
settings, which can be saved by choosing the Save Color Palette to INI File command from the
Editor Color menu.

The following information is saved in the IWPRO.INI file:

Editor Settings

- Visibility state of the Status Area
- Visibility state of the Tool Palette
- Visibility state of the Color Palette
- Visibility state of the Zooming Scroll Bar
- Visibility state of the Grid
- Type of Grid:

Line Grid
Dotted Grid

- Focus on Icon Open / Drag & Drop setting
- Advance to Next Icon on Open setting
- Display Border on Current Icon setting
- Popup Tools Menu on Right Click setting
- Color Palette setting:

Default Color Palette
Solid Colors Only
INI File Color Palette

- Color Palette color values (if Save Color Palette to INI File used)
- Mouse Pointer Type setting
- Save As directory (used for new icons)
- Window size and position

Viewer Settings

- Icon Library File Mode setting
- Show All on Directory Change setting
- Ask to Show Icons setting
- Just Beep on Invalid / No Icons setting
- Last viewed directory
- Save New Icon File (Change Icon in ProgMan) directory
- Window size and position



Glossary
Term Definition

Color Palette The part of the Editor window where you can 
select colors to use in editing an icon.

Dithered Colors Non-solid colors created by patterns of solid 
color dots.

Editor The window where you can create and edit 
icons.

Grid A pattern of dots or lines that you can display 
in the icon editing area of the Editor window 
to help position pixels in the icon.

Icon A 32 by 32 pixel image used in Windows to 
represent an application, disk file, and other 
objects.

Icon Boxes Six boxes in the Status Area of the Editor 
window that each displays a single icon open 
in the Editor.    You can also test-drag icons by
dragging them from the icon boxes.

Icon File A file type named with the extension of .ICO 
that contains a single icon.

Icon Library File A variety of file types (.EXE, .DLL, .ICL, 
etc.) containing one or more icons.

Icon Library File 
Mode

The icon viewing mode in the Viewer that 
allows you to view and extract icons in icon 
library files.    The other icon viewing mode 
allows you to view single icon files.

Inverse Color A solid color used in an icon that becomes 
transparent and inverts the pixels beneath 
when you drag the icon.

Screen Color A solid color used in an icon that becomes 
transparent when you drag the icon.

Status Area The region on the right side of the Editor 
window containing:
-    Six icon boxes
-    Original icon display
-    Mouse position display
-    Mouse color controls

Tool Palette The column of tools along the left side of the 
Editor window.    You use these tools to edit 



icons.    The tools are also available from the 
Editor Tools menu.

Viewer The window where you view icons and select 
icons to open in the Editor for editing.

Zooming Scroll Bar The scroll bar along the side of the Tool 
Palette that lets you zoom in and out of the 
editing area of the Editor.    You can zoom out 
to the actual icon size, and zoom in as far as 
the screen size will allow.

All Files Installed

Following are all of the files installed by Setup:

IconWorks Pro Directory

IWPRO.EXE The IconWorks Pro application.
IWPRO.HLP The IconWorks Pro Help file.
README.TXT The IconWorks Pro Read Me text file.
DWVSTAMP.VBX * Used by IconWorks Pro, and possibly other VB apps.
MHCOMD.VBX * Used by IconWorks Pro, and possibly other VB apps.
MHRUN400.DLL * Used by IconWorks Pro, and possibly other VB apps.

Windows System Directory

VER.DLL Used by Setup, other apps, and Windows itself.
SETUPKIT.DLL Used by Setup, and possibly other VB setup apps.
VBRUN300.DLL Used by Setup, IconWorks Pro, and all other VB apps.

Each file is installed only when it does not exist in the destination, or when it is newer than the 
existing file in the destination.    In the event you need to reinstall IconWorks Pro to replace a 
damaged file or whatever, you must first delete the appropriate files before reinstalling so the 
files will not be skipped over during the install.

*    These support files are installed to the IconWorks Pro directory if they do not already exist 
in the Windows System directory.    The idea is to reduce file clutter and make it easier to track 
which files belong to IconWorks Pro, useful for uninstalling.    If the files do exist in the 
Windows System directory already, then Setup will update them there if necessary.



Features and Notes

- By default, the Editor window appears when IconWorks Pro is run.    You can start 
IconWorks Pro with either the Editor, Viewer, or both windows open.    To do so, select the 
IconWorks Pro program item icon in Program Manager, and choose Properties from the 
File menu.    In the Program Item Properties dialog box, add a space and one of the 
following switches to the end of the Command Line edit field:

/V, -V, V, VIEW, VIEWER Start with Viewer instead of Editor.
/B, -B, B, BOTH Start with Editor and Viewer (Viewer has focus).

- A mouse, other pointing device, or mouse simulation software is definitely required for 
IconWorks Pro to be useful at all, since without one of them you would not be able to edit 
in the Editor.    You also would not be able to select icons in the Viewer when Icon Library 
File Mode is on if an icon library file contains more than one icon.

- In theory IconWorks Pro should run on a system with limited memory (like only 2 megs) if 
Windows itself runs at all on such a system.    The maximum number of icons that can be 
shown at one time may be reduced when Windows memory is limited, or very fragmented 
or swapping at the time.

- The way Multi Undo works is by creating temporary hidden .ICO files to restore to.    Icon 
extraction from icon library files works the same way, by first creating a temporary 
hidden .ICO file and then loading that.    So if you notice some disk access each time you 
make an edit in the Editor, and each time you click on an icon from an icon library file in 
the Viewer, this is the reason.    It should be hardly noticeable on even slow hard disk 
systems, since .ICO files are only 766 bytes.

- For an untitled new icon, the Directory in the Save As dialog will be set to either the last 
directory you saved to (which is remembered between Editor runs), or the current directory 
(as set by Windows on application startup or by the Viewer if it is open).    For an untitled 
icon extracted from an icon library file, the Directory in the Save As dialog will be set to 
the directory of the icon library file that the icon was extracted from; the reason for this is 
in case you want to save the icon file in the same directory.

- When an icon file is saved to the directory that is being viewed in the Viewer at the time 
(Icon Library File Mode off), the Viewer will update its display automatically if it is not 
minimized.    If you are viewing a directory with a lot of icon files in it, then you may want 
to minimize the Viewer before saving an icon to the directory being viewed to avoid the 
update delay.    Otherwise, change the viewed directory, turn on Icon Library File Mode, 
turn on the Ask to Show Icons option, or exit the Viewer first.

- In the Editor Save As dialog and in the Viewer Save New Icon File (Change Icon in 
ProgMan) dialog, you will see the icon that you are going to save in the upper icon box.    
You will also see any icon file that you highlight in the file list in the lower icon box, so 
you know what you may be overwriting.    These icons can be test-dragged as well.



- You have probably noticed that the Icons Loading counter in the Viewer counts down 
instead of up.    Since a great many icons can be viewed at once, counting down lets you 
know how much is left to load.    Being able to see the end coming lets you subconsciously 
justify the wait.    <g>

- With some video drivers, especially accelerated video cards with a "Device Bitmaps" 
setting, IconWorks Pro may report an error in some functions of the application.    If you 
receive this error, try disabling the video driver "Device Bitmaps" feature if applicable to 
your configuration, which usually fixes the problem.    Otherwise, a different video driver 
should be used, such as one that comes with Windows or another from the Microsoft 
Windows Driver Library.

- IconWorks Pro attempts to use the services of the file named CTL3D.DLL, only if it is 
found in the Windows System directory.    (CTL3D.DLL adds a 3-D look to message boxes 
and Common Dialogs boxes.)    Under certain conditions, IconWorks Pro may cause a GPF 
when it starts up, which has been traced to some kind of problem with CTL3D.DLL after 
other applications have been run.    To prevent this problem, or if you prefer to not use the 
look provided by CTL3D.DLL, add the line No CTL3D=1 to the IWPRO.INI file.    Use 
0 (zero) or remove the line to allow IconWorks Pro to use CTL3D.DLL.



Version History

1.01 - The use of CTL3D.DLL by IconWorks Pro can be disabled if necessary or desired.   
(See Features and Notes for info.)

- Fixed a problem with a certain message box in IconWorks Pro due to CTL3D.DLL 
limiting the amount of text displayed to 512 characters.    The problem did not 
appear if CTL3D.DLL was not being used.

- Changed the working of the "File Spec Note" in the IconWorks Pro Viewer.
- Setup now installs certain support files to the IconWorks Pro directory if those files 

do not already exist in the Windows System directory.    (See All Files Installed for 
info.)

- Setup no longer attempts to use CTL3D.DLL to avoid a potential problem.
- Help file additions and minor fixes.

1.0 The initial release.    Greatly enhanced and fixed up over previous versions of 
IconWorks (the last one was Release 6 of 1.00-VB3).




